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Printing the single page target

The Principle
To make a custom printer profile we need to measure exactly what
colours a printer actually prints without any interference from any
software in your work flow.
In order to measure this you need to print the supplied target file
without ANY colour management being applied AT ALL, at any stage.
The same principle applies with all printers, all printing software and
every operating system.
The target will fit onto a single A4 Portrait format sheet of paper.

Do NOT resize it to fit and do NOT cut the target out of a standard
sheet.

If you are printing on roll paper, please do not cut the target exactly
round the dotted limits, but leave at least an extra margin of about 1cm
around the box for handling purposes.

Please note this single page target set is ONLY suitable for normal
photo printing paper and we can't measure this target when printed on
other materials e.g. canvas or card. If in any doubt please email us,
info@colourprofiles.com, for advice to help save your time and
materials.

Once the target has been printed leave it to dry fully. Check them to
ensure that the dotted box is the correct size on all sheets, 267mm
x 190mm.

Please note that if you use Adobe Color Printer Utility with Windows
systems it resizes the targets to 255mm x 186mm and prints them off
centred on the page. In the specific case of ACPU this resizing is
acceptable, but not with any other software.

Please carefully package the target with a sheet of plain paper on top
of the sheet to prevent any damage, preferably with a sheet of card to
prevent damage in transit, fill in the order form, print it out and send it
all to us.

PLEASE ENSURE THAT YOUR EMAIL ADDRESS IS EASILY
READABLE.

To ensure prompt delivery check that the package is correctly stamped
with the correct amount.

Much of the detail below duplicates the instructions on our web site on
how to set up and use colour management. Please make sure you
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double check what's written below for your particular products before
printing out the targets.

Printing software settings

Printing software must be set to NOT to impose or change the colourspace of
the file and NOT to apply any sort of profile to the image sent to the printer.
Please read the instructions for each manufacturer and follow them exactly.
You may be surprised having read the above that the first instruction in most
sections will be to turn colour management ON, not off. The reason for this is
take control of the colour management system away from the operating
system defaults to ensure that no profile is unknowingly applied.

Adobe Products

Recent Adobe products Photoshop CS5, CS5.5, CS6, CC and all
versions of Lightroom

All the above products can't be used to print out printer profiling targets as it is
impossible to fully turn off colour management.
To get round this Adobe have a free utility to print out profiling targets, Adobe

Color Printer Utility. It can be downloaded from:-
http://helpx.adobe.com/photoshop/kb/no-color-management-option-missing.htmi

You will need to use this to print out our targets. The instructions for use are
on the download page.

Photoshop colour settings (all previous versions)

It's important that no colour management is ever applied to the target
files prior to printing.

In Photoshop this is controlled by the ‘Color settings dialogue’ found in
the edit menu.

© www.colourprofiles.com 2018



- - |
Color Settings
a Unsynchronized: Your Creative Suite applications are not
&? synchronized For consistent calor,
— Settings: | Colour managed for Adobe RGE kl R—
‘ Load...
— Whorking Spaces
R3B! |.'5.d0|:ie RiSE (1993) M _
EAHEE |u.5. e Coated (SWOP) w2 M Fewer Options
Gray: |Gra1,r Gamma 2.2 M
Presvig
[¥]

Spot: |Dnt Sain 209

— Color Management Palicies

RGB! | preserve Embedded Profles b

CMYE: | preserve Embedded Profiles b

aray: | o w

Profile Mismatches:  [w]agk when Cpening  []Ask wihen Pasting
Mizzing Profiles:  [w]agk when Cpening

— Conwversion COplions

Enaine: | adobe (ACE) v

Intent: | F.elative Colorimetric E]

Llse Elack Paint Compensation
Llse Dither [3-bitjchannel images)
Cnmpensate for Scene-referred Profiles

— Advanced Contrals

DDesaturate Monitor Caolors By 2IZI| kL
DBIend ReGE Colors Using Gamma: | 1,00

— Description

Colour managed for Adobe RGE:

The important settings are in the color management policies section.
Preserve embedded profiles, coupled with Missing profiles ‘Ask when
opening’

This should ensure that when you open the target files which are

untagged you get asked if you want to assign a profile or leave it
untagged.
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Photoshop CS3
Photoshop CS3 significantly improves printer management over
previous versions. To print without colour management applied, just
select "No Color Management" in the "colour management" option.
Please ensure 'scale fit to media' is NOT checked and that the
document is showing as 'Profile:untagged RGB' in the print box.
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(Note this screen shot shows one page of our canvas target set, not

the one page target)

Photoshop CS4

Photoshop CS4 is very similar to version CS3. To print without colour
management applied, just select "No Color Management" in the "colour

management" option.

Please ensure 'scale fit to media' is NOT checked and that the
document is showing as 'Profile:untagged RGB' in the print box.
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Like previous versions of Photoshop, when you've finished setting all
the printer settings, double check the "color handling" setting, it often
defaults back to a previous setting.

Photoshop Elements Colour settings (all versions up to 11)

It’'s important that no colour management is ever applied to the target
files prior to printing.

In Photoshop Elements this is controlled by the ‘Color settings
dialogue’ found in the edit menu.

© www.colourprofiles.com 2018




i

Cancel

I Fange.

ithir the &

The setting you need to select is ‘No color management’

The above screen shot is from Photoshop Elements 8, but all modern
versions have a similar options box.

After you've printed the targets you'll need to return to your normal
printing setting, either ‘Always optimize for printing’ or ‘Allow me to
Choose’

When you've finished setting all the printer settings, double check the
"Print Space: Profile" setting, it often defaults back to a previous
setting.

Then print the target.

Photoshop Elements 6
Make sure you've turned off colour management from the Edit menu;
go to Color Settings. From the dialogue box choose "No color
management"”
To print the target load the files into Photoshop Elements, ensure that
no colour management is applied when opening the file, then choose
the Print option on the File menu.
In the print dialogue select 'no color management' in the color handling
option in the color management box.

© www.colourprofiles.com 2018



DUTpLE

ColourProfigs com  Targel page 1 of ) Doledbox outing whould by 23em by 173mm

| Show Bournding Eoo

([ Frint.. | | Caricel

Frintiultiple Fhotos... Page Setup..

Please ensure 'scale fit to media' is NOT checked and that the
document is showing as 'Profile:untagged RGB' as the source space in
the color management box.

When you've finished setting all the printer settings, double check the
"Print Space: Profile" setting, it often defaults back to a previous
setting.

Then print the target.

(Note this screen shot shows one page of our canvas target set, not

the one page target)

Photoshop Elements 8 - 11

Make sure you've turned off colour management from the Edit menu;
go to Color Settings. From the dialogue box choose "No color
management"

Then load the target files into Photoshop Elements, ensure that no
colour management is applied when opening the file, then choose the
Print option on the File menu.
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Choose ‘individual print’ (option number 4), ‘Actual size’ for the print
size (option number 5), Crop to fit NOT checked.

Then click on ‘More Options’ and go to ‘Color management’

Select No Color Management in the color handling option box,
Check that Image space is reported as ‘untagged RGB'

The other options should be greyed out. Some versions allow you
choose a rendering intent, this is best set to relative colormetric.

When you've finished setting all the printer settings, double check the
"Print Space: Profile" setting, it often defaults back to a previous
setting.

Then print the target.

Lightroom (all versions)
Printing profiling targets from Lightroom is NOT recommended. Please
use another program such as Photoshop, Photoshop Elements or the

Adobe Color printer Utility that allows greater control over the printing
process.
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Printer driver settings
The printer driver needs to be set NOT to use any colour management.
Please read the instructions for each manufacturer and follow them
exactly.
Unfortunately there are so many different printers on the market, each
of which have may several different driver versions, it's impossible to
show the exact driver settings for every one. If you have any queries,
email us and we'll help you as much as we can.

The illustrations for this are taken from the Windows drivers for each
manufacturer, Mac drivers will look slightly different, but usually have
the same overall functions.

Epson
Main Tab:
Media Type: (as appropriate)
Color: check color option
Mode: Custom Then click: Advanced: In the advanced dialogue box:
Check paper type is correct;
Color still selected;
Print Quality 1440 dpi(or appropriate);
Microweave unchecked;
Edge smoothing unchecked;
Flip horizontal unchecked;
High speed unchecked;
Finest detail unchecked;
Color Mangement; No Color Management checked
Paper config at defaults
Paper tab:
Paper source; As appropriate
Paper Size; A4
Copies; 1
Orientation; Landscape (Rotate unchecked)
Printable area; Standard and centred
Layout Tab:

All unchecked

Please note some of these options may not be available

Epson 2100/220 printers.
If you have the grey balancer software installed please ensure that no correction is
set in the grey balancer software options.

Latest Epsons

The latest Epson Stylus Photo printers like the R800 and R1800 have a newer printer
driver design.

When you first use the driver you get the screen below, click on the advanced button
to get to the important colour management settings.

© www.colourprofiles.com 2018



&% EPSON Stylus Photo R1800 Properties

@_ﬁn_ ) Page Layout || @ Mah‘ulenatml
[~ Quslity Option -

B EEE &

" Dafl Test O Texth . O Photo O BestP.. O User

Paper Options | Prink Options

Souice |Sheet 7| I Boderless | I PhateErhance
Type |F'1ain Paper [ I™ Gloss I :lv

™ Reverse Orde
[ Piint Previess

Size: |44 2107 2537 mm

~Ink Levels - + — Onentation

UldUIR0 =

L ! b |
s bl | Show Seflings
Beset Defauts | Technical Support | Advanced

[ ok || cancel || Hebp

It's now worth checking the "Show this screen first" check box in the bottom right to
save time in future.
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Canon
Select the printer you wish to print to in the “Page setup” dialogue box;
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Click on Properties;
In the printer properties dialogue box you will need to make the following
settings on each tab.

Main Tab:
Select appropriate media type
Select appropriate media source
Print Quality: Select: Custom then “Set...”
In Custom settings select:
Quality: Fine
Halftoning: Diffusion
Color Adjustment: Select: manual then “Set...”
Set all the color Balance options to the centre 0 position
DO NOT check ICM box
Select Print Type: NONE
Greyscale Printing: unchecked
Preview before printing: unchecked
Page Set up Tab:
Page Size: A4
Orientation: Landscape
Printing Type: Normal-size printing
Borderless printing: unchecked
Duplex printing: unchecked
Copies: 1
Stamp/Background Tab:
Nothing selected
Effects Tab:
Nothing selected
Profiles Tab:
Nothing selected
Note: This tab/page is not connected with ICC/ICM colour printing
profiles, it just saves a set of driver settings. You may find it useful to
save the above settings as a default for printing with colour
management in future.

Hewlett Packard

HP recommend setting the Color Space option on the color tab
in their printer driver to "ICM enabled" when printing targets for
profiling. And NOT applying a profile in the printing software.

Others

Please consult your printer documentation and set the printer
driver NOT to apply any profile if possible.

© www.colourprofiles.com 2018



